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Introduction 
Welcome to this hands-on guide to mastering Microsoft Outlook! This e-book is designed 
specifically for students who are eager to learn the essential features of Microsoft Outlook 
in just five chapters. Whether you are just starting with Outlook or looking to refresh your 
skills, this practical guide will take you step-by-step through all the key aspects of the 
software. By the end of this e-book, you’ll have a solid understanding of Outlook’s 
capabilities and be ready to use it effectively for your personal and professional needs. 

Each chapter has been carefully structured to ensure that you not only understand the 
concepts, but can also practice them. This hands-on approach will allow you to engage 
with the material directly and apply what you’ve learned as you go. From managing your 
emails and calendar to organizing tasks and contacts, each chapter covers essential areas 
needed to enhance your Outlook experience. You will also learn how to customize your 
profile and set up useful tools like automatic email signatures and out-of-office replies. 

In just five chapters, you'll become proficient in Outlook and gain the confidence to use it 
as an indispensable tool for communication and organization. Here's a brief look at what 
you’ll cover: 

● Chapter 1: Learn how to effectively use Outlook Email, including categorizing and 
flagging messages to stay organized. 

● Chapter 2: Master the Calendar, from creating appointments to managing 
attachments and printing your schedules. 

● Chapter 3: Understand the use of Contacts and how to create and manage your 
address book. 

● Chapter 4: Dive into Task Lists and Notes, learning how to keep track of your to-do 
items and stay productive. 

● Chapter 5: Explore Outlook customization options to personalize your profile and 
create Rules to make your email management more efficient. 

This guide is built for students like you, who want to get hands-on experience and develop 
the skills to use Microsoft Outlook with confidence. Let’s dive in and start exploring how to 
make Outlook work for you!



Microsoft Outlook 
Chapter One - Outlook Email 

Developed by Alicia Cota, reviewed by Andres Martinez, and produced with the assistance of the California 
Community Colleges and Imperial Valley College 
 
 

    

Outlook Email 
Objectives of Chapter One 

1. Apply Different Email Viewing Options 
2. Categorize and Flag Email Messages 
3. Create an Email Auto-Signature 
4. Create and Initiate an Automatic Out-of-Office Email 

 Apply Different Email Viewing Options 
Microsoft Outlook is part of Microsoft Office. Outlook features a Ribbon at the top 
of the window that contains the tabs Home, View, and Help. The Ribbon shows 
different tools and options depending on which tab is selected. In this chapter, we 
will focus on the View tab (Figure 1).  

 
Figure 1.1. The View tab on the Ribbon is located at the top left of the window. 

The Ribbon in the View Tab  
● View settings allow quick access to Outlook settings, giving flexibility to 

customize user Outlook experience to suit specific needs. 
● Messages can be displayed individually or grouped. The user can also ask 

Outlook to show a message preview. 
● Collapse and extend conversations help users manage their email threads 

more effectively by condensing or expanding the view of the selected email 
(Figure 1.2). 

● Zoom allows the user zoom in or out of the view of the entire platform, 
making the content bigger or smaller as needed. 

● Sync synchronizes content and pulls in new emails. 
● Layout presents options in four areas: 

o Ribbon. The user can choose between a Classic or Simplified 
Ribbon. The classic ribbon displays more tools but takes up more 
space on the page. The simplified version shows fewer tools, but with 
the advantage of taking up less page space. 
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o Folder pane. The user can show or hide the folder view of the 
software and can toggle on or off the display of favorite folders.  

o Reading pane. The user can view display email information either at 
the bottom of the screen or on the right side. The user can also hide 
email information. 

o My day. Turning on My Day allows you to view your Calendar on the 
same page as the email Inbox, efficiently managing both at the same 
time (Figure 1.3). 

 
Figure 1.2. The Expand/Collapse Conversation option allows the user to toggle between views. When conversations are 

expanded, the full email message in each thread is shown. When they are collapsed, only the first line is shown. 
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Figure 1.3. Activating “My Day” in the Layout options opens a Calendar pane at the right of the Inbox window, allowing 

access to emails and calendar at the same time. 

 

Categorizing and Flagging Email Messages 

Categorizing Emails 
Outlook Categories is a powerful feature designed to help users quickly organize 
their emails, calendar events, contacts, and tasks. By assigning color-coded 
categories, you can quickly identify and group related items, making it easier to 
manage your workflow and stay on top of essential information. Whether you are 
sorting by project, priority, or personal preference, Outlook Categories offer a 
flexible and intuitive way to streamline your productivity and ensure that nothing 
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falls through the cracks. In this section, we will go step by step through how to 
create a new category and manage and view them. 

Create a New Category 
1. Click the Home tab and select a message from the Inbox to categorize. 
2. Move to the Category tool, which looks like a tag (Figure 1.4, point 1). 
3. Click on New Category (Figure 1.4 point 2). 
4. A “Create New Category” pop-up window will appear (Figure 1.5). Here, you can 

assign a name to the category, choose a color, and click the “Save” button to 
create the category. 

 
Figure 1.4. The Category tool is located on the Home tab of the Ribbon, near the right end. 
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Figure 1.5. The “Create new category” pop-up window allows you to name a new category and assign it a 

color.  

 

Manage Categories 
1. In the Home tab, click on the Categories tool/tag icon. 
2. From the pull-down menu, click on Manage Categories. 
3. A pop-up window appears for managing categories. Users can:  

a. Create a category (Figure 1.6 point a) 
b. Delete category (Figure 1.6 point b) 
c. Edit a category (Figure 1.6 point c) 
d. Favorite a category (Figure 1.6 point d) 

● Favorited categories will appear under “Favorites” on the left pane of the 
Mail view (Figure 1.7). 
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Figure 1.6. The Categories section of the Settings window allows you to (a) create a new category, (b) delete a category, 

(c) edit a category, of (d) define a category as favorite. 

 

 
Figure 1.7. Categories that have been added as favorites are visible under “Favorites” in the left pane of Mail view. 

View Categories 
The easiest way to see categories in Outlook is to click on the Category tool on the 
Home tab. The pull-down menu will show generic categories with color names and 
any custom categories you have added (Figure 1.8 point 1). 
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Figure 1.8. Click on the Category tool (point 1) to view the pull-down menu of available categories. 

Flagging Emails 
Another way to organize your emails is by flagging them. This method of organization 
is more straightforward than categories. It is often used when users have emails that 
do not need a category. To flag an email, select the email and look for the small flag 
icon that appears by the sender’s name (Figure 9). Clicking the icon flags the email, 
and the flag icon turns red (Figure 10). To see all your flagged emails, click on the 
Filter tool at the top of the Inbox pane and select “Flagged” (Figure 11). Outlook will 
display only flagged emails. 
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Figure 1.9. In the Inbox pane, an email that hasn’t been flagged has a clear flag icon. 

 
Figure 1.10. Once the flag icon has been clicked, it turns red and the email is officially flagged. 
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Figure 1.11. Click on the Filter tool icon (three stacked lines decreasing in length) to activate the pull-down menu. Select 

“Flagged” to see all flagged message. 

 

Creating an Email Signature 
Outlook allows users to show their style. Follow the steps below to create your own 
unique signature—and let your creativity lead! 

1. Access Settings by clicking the gear icon in the right corner of the toolbar at 
the top of the window (Figure 1.12). 

2. Click on Mail to access email settings (Figure 1.12, point 2) 
3. Select Compose and Reply (point 3) 
4. Give your signature a name (point 4) 
5. Create your signature, using fonts, text effects, and images as desired (point 

5). 
6. Click to save your signature. 
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Figure 1.12. Click the gear icon in the right corner of the toolbar to access Settings. 

 
Figure 1.12. Access signature options under “Compose and reply” in Mail Settings. 

After you create your signature, we suggest adding it to your emails by default. Use 
the pull-down menus for New Messages (Figure 1.14 point a) and Replies/Forwards 
(Figure 1.14 point b) to specify your preferred signature. 



Microsoft Outlook 
Chapter One - Outlook Email 

Developed by Alicia Cota, reviewed by Andres Martinez, and produced with the assistance of the California 
Community Colleges and Imperial Valley College 
 
 

    

 
Figure 1.13. Set the default signature for new messages (point a) and replies/forwards (point b) in the pull-down menus 

just below the signature preview area in Compose and Reply settings. 

Creating an Automatic Out-of-Office Email 
Outlook allows the option to send automatic replies to any email received in a 
specific period. This function is useful because it informs people who want to 
contact you that you are not in the office. 

1. Access Settings (Figure 1.12) 
2. Select Mail (Figure 1.13 point 2), and then Automatic replies in the Layout 

menu (point 3) 
3. Toggle the “Automatic replies on” switch to active (point 4) 
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4. Click the box next to “Send replies only during a time period” and enter the 
starting and ending dates for the period (Figure 1.14 point 5) 

5. Select any of the other options Outlook provides tools to help you manage 
your schedule, including “Block my calendar for this period,” “Automatically 
decline new invitations, and “Decline and cancel my meetings during this 
period.” for events that occur during this period” (point 6). 

6. Click on Save (point 8) to activate the process. 

 
Figure 1.14. The Automatic replies panel in settings, annotated with the location of the on/off switch (point 4), start and 

end times (point 5), additional options (point 6) and Save button (point 8). 
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Sample Out-of-Office Email Notification 
Thank you for your email. I am currently out of the office and will not be available until 
[return date]. During this period, I will have limited access to my email. 

If your matter is urgent, please contact [alternative contact name] at [alternative contact 
email or phone number]. They will be able to assist you in my absence. 

I appreciate your understanding and will get back to you as soon as possible upon my 
return. 

Best regards, 

[Your Full Name] 
[Your Job Title] 
[Your Company Name] 
[Your Phone Number] 
[Your Email Address]
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Outlook Calendar 
Objectives of Chapter Two 

1. Create and Maintain Appointments and Meetings 
2. Print Calendars in Different Views 
3. Add and View Calendar Attachments 

Appointment and Meeting Creation and Maintenance 

Creating an Event in Calendar 
Outlook offers Calendar as a tool for time management. In this section, we will create 
an event in the calendar. 

1. Open Calendar (Figure 2.1). 
2. Click the New Event button on the Home tab (Figure 2.2), which will open the 

“New Event – Calendar” pop-up window (Figure 2.3). 
a. Add a title for your event (point b). 
b. Invite attendees. (Optional; you can create a reminder purely for yourself 

and do not need to send an invitation to anyone) (point c). 
c. Indicate a starting date and time (point d) and end date and time (point e). 

Ending and starting dates can be on the same or different days.  
d. Update the time zone if necessary (point f). 
e. Indicate whether the event repeatsm, and if som when (point g). 
f. Toggle the switch to indicate if the event takes place in-person (point h). 
g. Toggle the switch if the event will occur in Microsoft Teams (point i). 
h. Add meeting details, including information and files (point j). 
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Figure 2.1. Calendar is located under Mail in the navigation bar at the left side of the window and is designated by a small 

icon in the shape of a calendar page. 

 
Figure 2.2. In Calendar view, the left pane shows the month’s days with the current date highlighted and includes the 

links “Add calendar” and “Go to my booking page.” The right pane gives a larger preview of the month, including events. 
The “New event” button is located at the top left corner on the Home tab. 
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Figure 2.3. The “New event – Calendar” pop-up window includes options for the event, including title (b), attendees (c), 

start and end dates (d and e), time zones (f), recurrences (g), in-person meeting (h), Teams meeting (i) and details (j). 

Editing an Event 
1. From the Calendar view, right-click on the event that you wish to update and click 

Edit (Figure 2.4) 
2. A new window will appear with the event details, in the order shown when the 

event was created (Figure 2.5). 
3. The user can update any of the parameters, and can also set up an automated 
3. event reminder (Figure 2.5 point 1). 
4. Click on More Options (Figure 2.5 point 2) to open a new pop-up window with all 

the modifiable details. 
5. When you have finished editing the event, click “Save” to finalize the changes 
5. (Figure 2.5 point 3). 
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Figure 2.4. In Calendar view, right-clicking an individual event pulls up a menu with the options Edit, Charm, Send to 

OneNote, Show as, Categorize, Private, Duplicate Event, and Delete. 

 
Figure 2. 5 Clicking to edit an event will open a pop-up menu with options to change the date, set a reminder (point 1), or 

access more options (point 2) 
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Printing Calendars in Different Views 

Outlook understands users have diverse needs regarding the best way to access their 
schedules. Some people have busy agendas, so they need to see their calendar view by 
day. Others may not have many appointments, so a monthly view can be more than 
enough to organize their time. In this section, we are going to identify how to change the 
calendar view depending on the user’s needs. 

Outlook shows the monthly Calendar view by default (Figure 2.6), but you can also view 
by week (Figure 2.7); work week (Figure 2.8); or day, which offers the most detail (Figure 
2.9). To print the calendar, select your preferred view and click the “Print” button.  

 
Figure 2.6. By default, Outlook shows the “month” Calendar view, and that option is highlighted here. 

 
Figure 2.7. Selecting “Week” on the Ribbon shows a full week, from Sunday to Saturday. 
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Figure 2.8. “Work week” view shows events occurring between Monday and Friday. 

 
Figure 2.9. “Day” view shows a single day’s events. 

 

Adding and Viewing Calendar Attachments 

Sometimes, it is necessary to add an invitation, agenda, map, or other file to an event. This 
practice can save you time because instead of having to go back to an e-mail or other 
document, the information is right in the Calendar event.  

Adding an Attachment to an Event Calendar 
1. Create or edit an event for editing, following the previously-outlined 

instructions. 
2. Below the details area is a gray bar with additional options. Click on the 

paperclip icon to open the attachment window (Figure 2.10). Follow the 
instructions there to upload your document. 
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Figure 2.10. Attach a file located at the bottom left of the window. 

Viewing a Calendar Event Attachment 
Event previews in the Outlook calendar don’t show attachments. The user must 
click to expand the preview window (Figure 2.11). At this point, attachments will be 
visible to the right of the paperclip icon in the Event pop-up window (Figure 2.12). 
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Figure 2.11. Event previews don’t show full details or attachments. To see the full event, click the “expand” arrow in the 

upper right corner. 

 
Figure 2.12. In the expanded view of the event, the attachment is visible to the right of the paperclip icon.



Microsoft Outlook 
Chapter Three - Outlook Contacts 

Developed by Alicia Cota, reviewed by Andres Martinez, and produced with the assistance of the California 
Community Colleges and Imperial Valley College 

P a g e  | 26 
 

    

Outlook Contacts 
Objectives of Chapter Three 

1. Create Contacts 
2. View and Sort Contacts 
3. Edit Contacts 
4. Use Contacts as an Address Book 

Creating Contacts 
Outlook allows you to create, view, sort, and edit contacts. To get started with 
managing your contacts, Select the “People” icon in the navigation bar (Figure 3.1). 
You can add new contacts in two ways, manually and by from profile cards. 

Add a Contact Manually 
1. From the  People view (Figure 3.1), click on the blue “New Contact” button in the 

Home tab (Figure 3.2) 
2. Fill out the form for new contact (Figure 3.3). 
3. Click “Save” to update. 

 

 
Figure 3.1. “People” is the third option down in the left navigation bar, under Mail and Calendar. Click the icon of two 

figures to access your contacts. 
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Figure 3.2. The New Contact button is under the Home tab in People view. 
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Figure 3.3. The New Contact pop-up window allows you to complete details about the individual you’re adding, including 

names, emails address, phone numbers, company, notes, and more. 

Add a Contact from Profile Card 
1. Open an email in the Mail view. 
2. In the email pane, click on the circle that has the sender’s picture or initials (Figure 

3.4) 
3. Scroll to the bottom of the window, and click the Add to Contacts button (Figure 

3.5) 
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Figure 3.4. To open a sender’s details, click on the circle beside the sender’s name, which shows either an image or 

initials. 

 

 
Figure 3.5. At the bottom of the email sender’s contact details pop-up window, click the “Add to contacts” button.  
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Sorting and Editing Contacts 

Outlook allows you to sort and edit contacts. These functions are helpful because 
sometimes you may have contacts for different purposes inside or outside your 
company, and sometimes they may change roles or contact information. 

Sorting Contacts 
By default, your contact list is sorted by first name. However, you can sort your 
contacts by any of the following parameters, depending on your needs: 

• First name 
• Last name 
• Company 
• Home City 
• Work City 
• Recently Added  

To change the sort order, simple click the pull-down menu by Your Contacts and 
select your preferred option (Figure 3.6).   

 
                      Figure 3.6. At the top of the Your Contacts pane, use the pull-down menu to determine sort order. 
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Editing Contacts 
In our daily lives, most information is constantly changing. The ability to update 
contact information is vital. Follow the steps to edit your contacts’ information. 

1. From the People view, click the contact you wish to update and click the 
“Edit contact” button (Figure 3.7) 

2. Update the fields in the pop-up window and click “Save” to finalize. 

 

 
Figure 3.7. To edit a contact, click to open their details, click the “Edit contact” button, and make any changes 

in the pop-up window. Click “Save” to finalize your changes. 

Creating a Contact List 
In cases where you find yourself sending emails to a specific group of people 
regularly, it is beneficial to create a list. This way, every time you need to send a new 
message to the same group of people, you can save time by clicking on the list 
instead of adding one contact at a time. 

1. Click on the down arrow beside the New contact button to expand the drop-
down menu (Figure 3.8 point 2) 

2. Select New contact list (point 3) 
3. In the New contact list pop-up window, give a name to your list (Figure 3.9 

point 4) and add the email addresses (point 5).  
4. Add a description, if desired, and click “Create” to finish. 
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   Figure 3.8. Click the arrow on the New contact button (point 2) to reveal the drop-down menu and select “New contact 

list” (point 3) to create your list. 

 

 
            Figure 3.9. The New contact list pop-up window lets you add a list name, email addresses, and a description.
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Outlook Tasks and Notes 
Objectives of Chapter Four 

1. Create a To-Do List Using Outlook 
2. Categorize Tasks 
3. Update Functions in Tasks 
4. Use Notes in Outlook 

Creating a To-Do List using Outlook 
Outlook gives you options for organizing your work. Sometimes, you have activities that 
don’t require a meeting or calendar event. In those cases, Tasks is the best option for 
helping you prioritize your activities and stay on track. You can assign a date and time 
for each activity you create. 

1. Click on To Do, which is represented by the checkmark icon and is the fourth on 
the navigation bar, below Mail, Calendar, and Contacts (Figure 4.1 point 1). 

2. Click on Tasks (point 2) 
3. Click on “Add a task” and give the activity a name (point 3) 
4. Add a due date if applicable (point 4) 
5. Click the “Add” button to save (point 5) 

 
Figure 4.1 Steps for adding a task include clicking “Add a task,” giving it a due date, and clicking “Add” to save. 
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Categorizing Tasks 

Having the ability to see all pending tasks in one place is valuable. In addition, 
Outlook allows you to organize tasks into groups. This requires categorizing your 
tasks. 

1. In the To Do view (Figure 4.2 point 1), select the task that you want to 
categorize (point 2) 

2. Click the Pick a Category button (point 3) 
3. Select an existing category or create a new one. 

 
Figure 4.2. You can add categories to existing tasks to make them easier to view and organize.  

Additional Tasks Functions 

Add Due Dates and Reminders to your Tasks 
You can select a task in any list to see its details. You can add additional steps, add 
it to My Day, add a due date or reminder, make it repeat, pick a category, add a 
file, or add a note. Scheduled tasks will automatically appear in the Planned smart 
list, where you can see your tasks due today, tomorrow, and beyond.  

Add a reminder 
1. Select a task (Figure 4.3 point 1). 

2. In the pane to the right, click Remind me and choose an option: later today, 
tomorrow, next week, or any date and time you choose (point 2). 
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Figure 4.3. Select the task (point 1) and then click Remind me (point 2) to customize a reminder. 

Add a due date 
1. Select a task to see its detailed view (Figure 4.4 point 1). 

2. Click “Add a due date” and choose when the task will be due: today, tomorrow, 
next week, or a date you pick (point 2). 

Set a date to repeat 
1. Select a task (Figure 4.4 point 1). 

2. Click “Repeat” and choose when your task will repeat: daily, on weekdays, 
2. weekly, monthly, yearly, or a custom repetition (point 3). 

 
Figure 4.4. Under the Remind Me is the option to add a due date over the name of Overview. 
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Add steps, Importance, and Notes to Your Tasks 
Add steps to your task 

Use steps to break your larger tasks down into smaller, more actionable pieces. To 
add a step: 

1. Select the task (Figure 4.4 point 1). Click  on “+ Add step” (point 4), and begin 
typing to add another step. 

2. When you’ve finished, hit Enter on the keyboard or click “Add” to save and 
close. 

To help keep you on track, a counter beneath each task's name displays the total 
number of steps the task contains and the ones you’ve completed so far.  

Prioritize tasks 
Add priority to the tasks by starring the most important tasks in each list. Once 
starred, tasks will automatically show up in the “Important” list. You can also sort 
each list by importance to have your starred tasks automatically moved to the top of 
the list. 

Using Notes in Outlook 
You can add additional information for each task by adding a note. Select the task 
to open the detailed view (Figure 4.5 point 1), then select Add a note (point 2).  

 
Figure 5.5. Select “Add a note,” near the bottom of the task detail pane at the right of the window, to include additional 

details.
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Customize your Outlook  
 Objectives of Chapter Five 

1. Add a Picture to your Profile 
2. Set Up Outlook Email Rules 

 

 Adding a Picture to your Profile 
You can personalize your profile by adding an image. Most people find it easier to 
remember a face than a name. Additionally, it can give members of your 
organization the sensation of interacting with a person. 

1. Open your profile by clicking the circle icon at the top right corner of the window. 
If you haven’t added a picture, you’ll see your initials (Figure 5.1). 

2. In the pop-up, click on the large circle with your initials (Figure 5.2). 
3. Upload your desired profile photo, and drag it to your preferred size and 

orientation within the guidelines (Figure 5.3). 
4. Click the “Apply” button, and then the “Done” button. 

 

Figure 5.1. To open your profile, click on the circle in the top right corner of the window that has your initials. 
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Figure 5. 2. To upload or change your profile picture, click on the large circle with your initials. 

 
Figure 5.3. In the “Change your photo” pop up window, upload an image from your computer and drag/resize it to fit the 

round frame. 
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Outlook Email Rules  
Rules help users organize their emails. Email rules in Microsoft Outlook are automated 
actions that manage your incoming (and sometimes outgoing) messages based on criteria 
you define. Here’s how to set them up: 

1. Open Settings by clicking the gear icon on the top toolbar (Figure 5.4). 
2. Click Mail in the far left column and then Rules in the middle column 

(Figure 5.5) 
3. Click “+ Add new rule” (Figure 5.6). 
4. Give your rule a name, a condition, and an action, and click to save (Figure 

5.7). 
5. In the example given here, the user has given the rule the name IVC. The 

condition is that an email is received from user “VF.” The action is that the 
message is moved to the folder called IVC. The user has the option to click 
on the checkbox “Run the rule now,” which would activate the rule as soon 
as it is saved, moving any existing emails from VF (as well as ones that 
arrive in the future) to the folder IVC (Figure 5.8). 
 

 
Figure 5.4. Click on the gear icon in the toolbar at the top of the screen to open Settings. 
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Figure 5.5. The Rules tool is under Mail in Settings. 

 

 
Figure 5.6. To add a new email rule, click “+ Add new rule” in the Rules section of Settings. 
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Figure 5.7. To create a new Rule, add a name, condition, and an action, then click to save. 
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Figure 5.8. In this sample rule, which the user has named IVC, the condition is that the email be from user VF. The action 

is that the message be moved to the folder IVC. If the user checks the box “run rule now,” any messages already in the 
Inbox, as well as future ones that may arrive, will be moved to the folder IVC when the user clicks “Save.” 

Manage Rules 
 To update existing rules: 

1. Go to Settings and open the Rules panel 
2. For each Rule, you have the following options (Figure 5.9). 

a. Run the Rule (a “play” icon, point a). 
b. Edit the Rule (a pencil icon, point b). 
c. Delete the Rule (a trashcan icon, point c). 
d. Activate/ Deactivate the Rule (a toggle switch, point d).  
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Figure 5.9. Once a Rule is added, you can manage it in Settings. You have the option to run (point a), edit (point b) or 

delete (point c) it, or to toggle it off and on. The text beside the Rule called “IVC” says, “If the message was received from 
VF, move the message to folder ‘IVC’ and stop processing more rules on this message.” 
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